Chapter 379

Mixed Models Tests for Two Proportions in a 3-Level Hierarchical Design (Level-3 Randomization)

Introduction

This procedure calculates power and sample size for a three-level hierarchical mixed-effects logistic regression model which is randomized at the third level. The goal of the study is to compare two group proportions. The study may be cross-sectional or longitudinal.

In a cross-sectional version of this design, students (first level units) are nested in classrooms (second level units) which are nested in schools (third level units). Each school is randomized into one of two intervention groups; e.g., treatment and control.

In a longitudinal version of this design, repeated measurements (first level units) are nested in patients (second level units) which are nested in clinics (third level units). Each clinic is randomized into one of two intervention groups; e.g., treatment and control.

Note that companion procedures analyze the other cases in which the randomization occurs at the first, or second, level.
Technical Details

Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 6, section 6.7.1, pages 223-225. The hierarchical mixed model used for the analysis is

\[
\log \left( \frac{p_{ijk}}{1 - p_{ijk}} \right) = \beta_0 + \delta X_{ijk} + u_i + u_{j(i)}
\]

where

- \(Y_{ijk}\) is the binary response of the \(k^{th}\) level-1 unit of the \(j^{th}\) level-2 unit of the \(i^{th}\) level-3 unit.
- \(p_{ijk}\) is an expected value defined by \(p_{ijk} = E(Y_{ijk} \mid X_{ijk})\). Assume \([p_{ijk} \mid (X_{ijk} = 0)] = p_2\) and \([p_{ijk} \mid (X_{ijk} = 1)] = p_1\)
- \(\beta_0\) is the fixed intercept.
- \(\delta\) is the treatment effect of interest. It is the difference between the two group proportions.
- \(X_{ijk}\) is an indicator variable that is 1 if \(i^{th}\) unit is in group 1 and 0 if it is in group 2.
- \(u_i\) is the level-3 random intercept effect for the \(i^{th}\) level-3 unit. It is distributed as \(N(0, \sigma_3^2)\).
- \(u_{j(i)}\) is the level-2 random intercept effect for the \(j(i)^{th}\) level-2 unit. It is distributed as \(N(0, \sigma_2^2)\).
- \(\rho_1\) is the correlation among level-1 units which are in a particular level-2 unit. For fixed models like this, \(\rho_1 = Corr(Y_{ijk}, Y_{ijk'}) = (\sigma_2^2 + \sigma_3^2)/\sigma^2\).
- \(\rho_2\) is the correlation among level-2 units which are in a particular level-3 unit. For fixed models like this, \(\rho_2 = Corr(Y_{ijk}, Y_{ijk''}) = (\sigma_3^2)/\sigma^2\).
- \(C_1\) is the number of level-3 units assigned to group 1.
- \(C_2\) is the number of level-3 units assigned to group 2.
- \(K\) is the number of level-2 units per level-3 unit.
- \(M\) is the number of level-1 units per level-2 unit.

The test of significance of the \(X_{ijk}\) term in the logistic model is the test statistic of interest. It tests the difference of the two group proportions.

Assume that \(\delta = p_1 - p_2\) is to be tested using a z-test (large sample). The statistical hypotheses are \(H_0: \delta = 0\) vs. \(H_a: \delta \neq 0\). The test statistic is the regression coefficient of the \(X_{ijk}\) term in a mixed model.

The power can be calculated using

\[
\text{Power} = \Phi\left\{ \frac{p_1 - p_2}{\sqrt{C_2KM/f_3}} - \Phi(1 - \alpha/2)\sqrt{(1 + 1/\lambda)p(1 - p)} \right\} \sqrt{p_2(1 - p_2) + p_1(1 - p_1)/\lambda}
\]

where \(\lambda = C_1/C_2\), \(\bar{p} = (C_1p_1 + C_2p_2)/(C_1 + C_2)\), and \(f_3 = 1 + M(K - 1)\rho_2 + (M - 1)\rho_1\).
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Effect Size, Power, C1, K, and M.

Under most situations, you will select either Power to calculate power or C1 to calculate the number of level-3 units. Occasionally, you may want to fix C1 and C2 and calculate K or M.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary search is made using an iterative procedure until an appropriate value is found. This search considers only integer values of C1, K, or M.

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered or a range of values such as $0.8$ to $0.95$ by $0.05$ may be entered.

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.

Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as $0.01$ 0.05 0.10 or $0.01$ to $0.10$ by $0.01$. 
Sample Size

C1 (Level 3 Units Assigned to Group 1)
This is the number of level 3 units in group 1 (treatment group). The sample size for this group is equal to Ceiling(C1 * K * M).

Examples of level 3 units are schools, clinics, hospitals, or cities.
A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are the level 1 units.
A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive integer.
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.

C2 (Level 3 Units Assigned to Group 2)
This is the number of level 3 units in group 2 (control group). The sample size for this group is equal to Ceiling(C2 * K * M).

Examples of level 3 units are schools, clinics, hospitals, or cities.
A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are the level 1 units. A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive integer.

Using Multiples of C1
If you simply want a multiple of the value for group 1, you would enter the multiple followed by "C1", with no blanks. If you want to use C1 directly, you do not have to enter the leading "1". For example, all of the following are valid entries:
C1 2C1 0.5C1 1.5C1.
You can use a list of values such as "10 20 30" or "C1 2C1 3C1".

K (Level 2 Units Per Level 3 Unit)
This is the average number of level 2 units in each level 3 unit. Examples of level 2 units are classrooms or patients.
A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are the level 1 units. A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive number that is at least 1.
It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up to the next largest integer.
You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list.
**M (Level 1 Units Per Level 2 Unit)**

This is the average number of level 1 units in each level 2 unit. Examples of level 1 units are repeated measurements or students.

A *cross-sectional* study might include schools as the level 3 units, classrooms as the level 2 units, and students are the level 1 units. A *longitudinal* study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.

This value must be a positive number that is at least 1.

It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up to the next largest integer.

You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list.

---

**Effect Size**

**P1 Input Type**

Indicate what type of values to enter to specify the effect size: P1 - P2. Regardless of the entry type chosen, the test statistics used in the power and sample size calculations are the same. The value of P1 is calculated from the value entered. This option is simply given for convenience in specifying the effect size.

The choices are

- **Proportions**
  - Enter P1 (Group 1 Proportion|H1) and P2 (Group 2 Proportion).

- **Differences**
  - Enter D1 (Difference|H1 = P1-P2) and P2 (Group 2 Proportion).

- **Ratios**
  - Enter R1 (Ratio|H1 = P1/P2) and P2 (Group 2 Proportion).

- **Odds Ratios**
  - Enter OR1 (Odds Ratio|H1 = Odds1/Odds2) and P2 (Group 2 Proportion).

**P1 (Group 1 Proportion |H1)**

Enter a value for the proportion in group 1 (the experimental or treatment group) under the alternative hypothesis, H1. The power calculations assume that this is the actual value of the proportion.

You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.

Note that values must be between zero and one and cannot be equal to P2.

**D1 (Difference|H1 = P1 – P2)**

This option specifies the difference between the two proportions under the alternative hypothesis, H1. This difference is used with P2 to calculate the value of P1 using the formula: P1=Diff+P2.

The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment group).

You can enter a single value such as 0.05 or a series of values such as 0.03 0.05 0.10 or 0.01 to 0.05 by 0.01.

Differences must be between -1 and 1. They cannot take on the values -1, 0, or 1.
**R1 (Ratio|H1 = P1/P2)**
This option specifies the ratio between the two proportions P1 and P2. This ratio is used with P2 to calculate the value of P1 using the formula: $P_1 = (\text{Ratio}) \times P_2$.

The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment group).

You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Ratios must be greater than zero. They cannot take on the value of one.

**OR1 (Ratio|H1 = Odds1/Odds2)**
This option specifies the ratio of P1 and P2, where P1 is the proportion in group 1 under the alternative hypothesis. This ratio is used with P2 to calculate the value of P1 using the formula: $P_1 = R_1 \times P_2$.

The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment group).

You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Ratios must be greater than zero. They cannot take on the value of one.

**P2 (Group 2 Proportion)**
Enter a value for the proportion in group 2 (the control, baseline, standard, or reference group).

Values must be between 0 and 1.

You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.

---

**Effect Size – Within Level Correlations**

**ρ1 (Correlation Among Level 1 Units)**
This is the correlation of each pair of level 1 units in a particular level 2 unit.

Possible values are from 0 to just below 1. For fixed slope models, $\rho_1 \geq \rho_2$. Typical values are between 0.0001 and 0.5.

You may enter a single value or a list of values.

**ρ2 (Correlation Among Level 2 Units)**
This is the correlation of each pair of level 2 units in a particular level 3 unit.

Possible values are from 0 to just below 1. For fixed slope models, $\rho_1 \geq \rho_2$. Typical values are between 0.0001 and 0.5.

You may enter a single value or a list of values.
Example 1 – Calculating Power

Suppose that a three-level hierarchical design is planned in which there will be students (level-1) which are nested in classrooms (level-2) which are nested in schools (level-3). This analysis will calculate the power for testing the significance of the difference in proportions of two interventions. There will be one measurement per student and treatments will be applied to schools (level-3 units).

The analysis will use a mixed logistic regression model. The following parameter settings are to be used for the power analysis: $P_1 = 0.6; P_2 = 0.5; \rho_1 = 0.02; \rho_2 = 0.01; K = 10; M = 10, 20; \alpha = 0.05$; and $C_1 = C_2 = 6$ to $12$ by $2$.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Proportions in a 3-Level Hierarchical Design (Level-3 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
Design Tab | 
Solve For | Power
Alpha | 0.05
C1 (Level 3 Units Assigned to Group 1) | 6 8 10 12
C2 (Level 3 Units Assigned to Group 2) | C1
K (Level 2 Units Per Level 3 Unit) | 10
M (Level 1 Units Per Level 2 Unit) | 10 20
P1 Input Type | Proportions
P1 (Group 1 Proportion|H1) | 0.6
P2 (Group 2 Proportion) | 0.5
\rho_1 (Correlation Among Level 1 Units) | 0.02
\rho_2 (Correlation Among Level 2 Units) | 0.01

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total N</th>
<th>Grp 1 Lvl 3 Units</th>
<th>Grp 2 Lvl 3 Units</th>
<th>Grp 1 Lvl 2 Units</th>
<th>Grp 2 Lvl 2 Units</th>
<th>Grp 1 Lvl 1 Units</th>
<th>Grp 2 Lvl 1 Units</th>
<th>Grp 1 Prop</th>
<th>Grp 2 Prop</th>
<th>Prop Diff</th>
<th>Grp 1 Prop Corr</th>
<th>Grp 2 Prop Corr</th>
<th>Lvl 1 Corr</th>
<th>Lvl 2 Corr</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.6759</td>
<td>1200</td>
<td>6</td>
<td>6</td>
<td>10</td>
<td>10</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.7896</td>
<td>2400</td>
<td>6</td>
<td>6</td>
<td>10</td>
<td>20</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.7972</td>
<td>1600</td>
<td>8</td>
<td>8</td>
<td>10</td>
<td>10</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.8915</td>
<td>3200</td>
<td>8</td>
<td>8</td>
<td>10</td>
<td>20</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.8775</td>
<td>2000</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9466</td>
<td>4000</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9280</td>
<td>2400</td>
<td>12</td>
<td>12</td>
<td>10</td>
<td>10</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9747</td>
<td>4800</td>
<td>12</td>
<td>12</td>
<td>10</td>
<td>20</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
References

Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of level-1 units.
C1 and C2 are the number of level-3 units assigned to groups 1 and 2, respectively.
K is the average number of level-2 units per level-3 unit.
M is the average number of level-1 units per level-2 unit.
P1 is the proportion for group 1 (treatment group) assuming the alternative hypothesis.
P2 is the proportion for group 2 (control group). This is the proportion in the standard, reference, baseline, or control group.
Prop Diff = P1 - P2 is the difference in the group proportions assumed by the alternative hypothesis.
p1 is the correlation among level-1 units in a particular level-2 unit.
p2 is the correlation among level-2 units in a particular level-3 unit.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.

Summary Statements
The total sample size of 1200, which were obtained from 6 level-3 units in group one and 6 level-3 units in group two with an average of 10 level-2 units per level-3 unit and an average of 10 level-1 units per level-2 unit, achieve 68% power to detect a difference between the group proportions of at least 0.1000. The proportion in group 1 is assumed to be 0.6000 under the alternative hypothesis. The proportion in group 2 is 0.5000. The correlation of level-1 units within a level-2 unit is 0.020. The correlation of level-2 units within a level-3 unit is 0.010. A test based on a mixed-effects logistic regression is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section
These plots show the power versus the level-3 count for the two values of M.
Example 2 – Calculating Sample Size (Level-3 Units)

Continuing with the last example, suppose the researchers want to determine the number of schools needed to achieve 90% power for the two values of M.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Proportions in a 3-Level Hierarchical Design (Level-3 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>C1 (Number Level 3 Units)</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>C2 (Level 3 Units Assigned to Group 2)</td>
<td>C1</td>
</tr>
<tr>
<td>K (Level 2 Units Per Level 3 Unit)</td>
<td>10</td>
</tr>
<tr>
<td>M (Level 1 Units Per Level 2 Unit)</td>
<td>10 20</td>
</tr>
<tr>
<td>P1 Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P1 (Group 1 Proportion</td>
<td>H1)</td>
</tr>
<tr>
<td>P2 (Group 2 Proportion)</td>
<td>0.5</td>
</tr>
<tr>
<td>p1 (Correlation Among Level 1 Units)</td>
<td>0.02</td>
</tr>
<tr>
<td>p2 (Correlation Among Level 2 Units)</td>
<td>0.01</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for Comparing Two Proportions</th>
</tr>
</thead>
<tbody>
<tr>
<td>H0: P1 = P2, H1: P1 ≠ P2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power</th>
<th>Total N</th>
<th>Grp 1 Lvl 3 Units</th>
<th>Grp 2 Lvl 3 Units</th>
<th>Lvl 2 Units</th>
<th>Lvl 1 Units</th>
<th>Grp 1 Prop</th>
<th>Grp 2 Prop</th>
<th>Prop Diff</th>
<th>Lvl 1 Corr</th>
<th>Lvl 2 Corr</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9058</td>
<td>2200</td>
<td>11</td>
<td>11</td>
<td>10</td>
<td>10</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9235</td>
<td>3600</td>
<td>9</td>
<td>9</td>
<td>10</td>
<td>20</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>0.020</td>
<td>0.010</td>
<td>0.050</td>
</tr>
</tbody>
</table>

This report shows the power for each of the scenarios.
Example 3 – Calculating Sample Size (Number of Level-2 Units)

Continuing with the last example, suppose the researchers want to determine the number of classrooms (level-2 units) needed to achieve 90% power for \( M = 10, 20 \) when \( C_1 = C_2 = 10 \).

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the **Mixed Models Tests for Two Proportions in a 3-Level Hierarchical Design (Level-3 Randomization)** procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the **File** menu and choosing **Open Example Template**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>( K ) (Number Level 2 Units Per Level 3 Unit)</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>( C_1 ) (Level 3 Units Assigned to Group 1)</td>
<td>10</td>
</tr>
<tr>
<td>( C_2 ) (Level 3 Units Assigned to Group 2)</td>
<td>( C_1 )</td>
</tr>
<tr>
<td>( M ) (Level 1 Units Per Level 2 Unit)</td>
<td>10 20</td>
</tr>
<tr>
<td>P1 Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P1 (Group 1 Proportion</td>
<td>H1)</td>
</tr>
<tr>
<td>P2 (Group 2 Proportion)</td>
<td>0.5</td>
</tr>
<tr>
<td>( \rho_1 ) (Correlation Among Level 1 Units)</td>
<td>0.02</td>
</tr>
<tr>
<td>( \rho_2 ) (Correlation Among Level 2 Units)</td>
<td>0.01</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Numeric Results for a Three-Level Hierarchical Mixed Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group 1 Level 3 Units</td>
</tr>
<tr>
<td>-----------------------</td>
</tr>
<tr>
<td>Power</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

This report shows the necessary value of \( K \) for each value of \( M \).
Example 4 – Validation using Ahn, Heo, and Zhang (2015)

Ahn, Heo, and Zhang (2015) page 226 provide a table in which several scenarios are reported. We will validate this procedure by the first row of the table. The following parameter settings were for the analysis: power = 0.80; \( P_1 = 0.5 \); \( P_2 = 0.4 \); \( \rho_1 = 0.1 \); \( \rho_2 = 0.05 \); \( K = 4 \); \( M = 5 \); and \( \alpha = 0.05 \). These settings resulted in a value of \( C_1 \) and \( C_2 \) (their \( N_3^{(0)} \)) of 42 and an attained power of 0.803.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Proportions in a 3-Level Hierarchical Design (Level-3 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>( C_1 ) (Number Level 3 Units)</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>( C_2 ) (Level 3 Units Assigned to Group 2)</td>
<td>( C_1 )</td>
</tr>
<tr>
<td>( K ) (Level 2 Units Per Level 3 Unit)</td>
<td>4</td>
</tr>
<tr>
<td>( M ) (Level 1 Units Per Level 2 Unit)</td>
<td>5</td>
</tr>
<tr>
<td>( P_1 ) Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>( P_1 ) (Group 1 Proportion</td>
<td>H1)</td>
</tr>
<tr>
<td>( P_2 ) (Group 2 Proportion)</td>
<td>0.4</td>
</tr>
<tr>
<td>( \rho_1 ) (Correlation Among Level 1 Units)</td>
<td>0.1</td>
</tr>
<tr>
<td>( \rho_2 ) (Correlation Among Level 2 Units)</td>
<td>0.05</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for Comparing Two Proportions</th>
</tr>
</thead>
<tbody>
<tr>
<td>H0: ( P_1 = P_2 ). ( H_1: P_1 \neq P_2 )</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power</th>
<th>Total N</th>
<th>Grp 1 Lvl 3 Units</th>
<th>Grp 2 Lvl 3 Units</th>
<th>Lvl 2 Units</th>
<th>Lvl 1 Units</th>
<th>Grp 1 Prop P1</th>
<th>Grp 2 Prop P2</th>
<th>Prop Diff</th>
<th>Lvl 1 Corr p1</th>
<th>Lvl 2 Corr p2</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8034</td>
<td>1680</td>
<td>42</td>
<td>42</td>
<td>4</td>
<td>5</td>
<td>0.5000</td>
<td>0.4000</td>
<td>0.1000</td>
<td>0.100</td>
<td>0.050</td>
<td>0.050</td>
</tr>
</tbody>
</table>

PASS calculates the same values of \( C_1 \) and power: 42 and 0.8034.